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Woord vooraf bij de derde druk

Bij veel hbo-opleidingen is SPSS de standaard als softwarepakket voor het 
verwerken van marktonderzoeksgegevens. Studenten beleven doorgaans 
veel plezier aan het werken met het pakket, maar de organisatie van het 
onderwijs om SPSS-vaardigheden aan te leren is voor menige opleiding een 
hoofdpijndossier. Dit boek bevat een stap-voor-stap-zelfinstructie dat dit 
probleem oplost. Studenten kunnen met deel  individueel, of klasgewijs 
onder begeleiding, in hun eigen tempo de stof doorwerken. Deel  bevat 
voorbeelden van veelvoorkomende praktijkstituaties. Studenten kunnen 
het raadplegen wanneer ze daar in een later stadium van de studie of in de 
praktijk mee in aanraking komen.

Het boek sluit aan bij de competentieniveaus die op hbo-opleidingen in 
bijvoorbeeld het economische en communicatiedomein gangbaar zijn: be-
schrijvende statistiek voor het propedeuseniveau (deel ) en schaaltechnie-
ken en toetsing voor in de hoofdfase (deel ).

Deel  van deze derde druk is ten opzichte van de tweede druk inhoudelijk 
ongewijzigd. Het taalgebruik is geactualiseerd en de uitleg is aangepast op 
plaatsen waar studenten vaak vragen stelden. Deel  is geheel vernieuwd. Er 
is een hoofdstuk met uitleg over het werken met de Likert- en Osgoodschaal 
toegevoegd; het hoofdstuk over statistisch toetsen heeft een logischer op-
bouw gekregen en de voorbeelden zijn geactualiseerd. Dit om nog betere 
aansluiting te vinden bij de wensen van hbo-opleidingen.

Deze druk is gebaseerd op IBM SPSS  Statistics, de vorige editie op PASW 
SPSS versie . De aanpassing van de naam is het gevolg van een eigenaars-
wisseling. In het vervolg van dit boek duiden we het programma aan als 
SPSS.

De instructie is geschreven voor hbo-opleidingen, maar universitaire stu-
denten met een relatief licht onderzoekspakket en beginnende marktonder-
zoekers hebben met eerdere drukken de weg naar deze uitgave al gevonden.

Op het basisniveau waar deze handleiding over gaat is SPSS zo goed als ver-
sieonafhankelijk. Gebruikers van SPSS-versie  zijn nog goed bediend met 
de tweede druk van dit boek, terwijl deze derde druk ook bruikbaar is voor 
eerdere versies van SPSS dan . Het is onwaarschijnlijk dat met nieuwe 
SPSS-uitgaven deze handleiding niet meer te gebruiken zal zijn.

Om een hoog praktijkgehalte te bereiken, komen in deze editie een groot 
aantal casussen voor. Al deze casussen zijn fictief.
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Dit boek vormt met de zusteruitgave Statistiek voor marktonderzoek, van 
dezelfde auteur en uitgever, een ideale combinatie.

We hopen dat gebruikers veel plezier beleven aan dit werkboek. Nuttig is 
één ding, maar marktonderzoek is een mooi vak en het werken met SPSS 
hoort daarbij. Het moet leuk zijn om mee te werken. Pas dan is de uitgave 
geslaagd.

Rein Memelink
Eindhoven, voorjaar 
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Wie een marketingopleiding aan een hbo-instelling volgt, zal onvermijdelijk 
in aanraking komen met marktonderzoek en daarmee met het verwerken 
van marktonderzoeksgegevens op de computer. SPSS (Statistical Package 
for Social Scientists) is op veel scholen en in de beroepspraktijk het meest 
gebruikte pakket.
Er zijn meer SPSS-instructieboeken in de handel, goede ook. SPSS voor 
marktonderzoek is echter het enige met een lesopbouw dat als werkboek 
gebruikt kan worden en tevens het enige dat precies de voor veel hbo-oplei-
dingen benodigde kennis afbakent.

Het boek is geschreven vanuit het perspectief dat marktonderzoek, statistiek 
en SPSS één geheel vormen en beschrijft daarom niet slechts hoe je tabel-
len en grafieken maakt, maar ook hoe je deze verwerkt en beschrijft in een 
onderzoeksverslag.
Daarnaast is (in de hoofdstukken  en ) uitleg over Excel opgenomen, dat 
soms handiger werkt dan SPSS.

De opzet is dat individueel, thuis of in de les, groepsgewijs, onder begelei-
ding van een docent of onderwijsassistent, wordt gewerkt aan SPSS-vaardig-
heden.

Deel  bevat vier lessen. Om ze door te werken, heeft een doorsnee hbo-
propedeusestudent per les ongeveer , uur nodig.

Deel  is bestemd voor wie verder gevorderd is. Het werken met schaaltech-
nieken (Likert en Osgood) en statistische toetsen komen aan de orde.
De lesstructuur is in dit deel losgelaten; de stof dient als naslagwerk.

SPSS voor marktonderzoek sluit aan op trends als leren op afstand en vraag-
gestuurd onderwijs, omdat het studenten in staat stelt zelfstandig en in 
eigen tempo, thuis of op school, eventueel met een bestand van een eigen 
marktonderzoeksproject, aan de competenties te kunnen werken.

De uitgebreide website www.spssvoormarktonderzoek.noordhoff.nl bevat 
de oefenbestanden die in dit boek staan, maar ook extra oefenopgaven 
en -tentamens. De site bevat tevens een docentengedeelte met toetsen, 
 inclusief de uitwerkingen daarvan.

Studiewijzer

http://www.spssvoormarktonderzoek.noordhoff.nl
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Deel  van dit boek is opgebouwd in lesvorm. Het bevat kennis en vaardig-
heden die bij de meeste hbo-opleidingen op propedeuseniveau vereist zijn.

Het doorwerken van de vier eerste hoofdstukken vergt per stuk ongeveer 
anderhalf uur tijd.

De opzet is te voorzien in stap-voor-stap lesmateriaal, waarmee je als stu-
dent in werkcolleges, al dan niet onder begeleiding, op een plezierige ma-
nier en in je eigen tempo leert met SPSS te werken. Zelfstudie is ook een 
goede optie. En het spreekt voor zich dat het boek als naslagwerk blijvende 
waarde heeft.

Op de website spssvoormarktonderzoek.noordhoff.nl zijn oefenopgaven te-
rug te vinden. Deze opgaven staan geordend per les. Je vindt op de website 
ook alle SPSS-bestanden die nodig zijn in de lessen.
Op een alleen voor docenten toegankelijk deel van de website zijn toetsen 
met uitwerkingen te vinden.

In de eerste les (hoofdstuk ), valt te lezen welke basishandelingen nodig 
zijn om met het programma om te gaan. Je leert hoe je gegevens in de com-
puter kunt invoeren, hoe je het bestand ‘opmaakt’, hoe je eenvoudige fre-
quentietabellen kunt maken en hoe je daarover rapporteert.
Hoofdstuk  start met herhalingsoefeningen van de stof uit les . Daarna 
maak je afbeeldingen van gegevens uit een computerbestand, bereken je 
statistische kerncijfers en leer je hoe je nieuwe variabelen kunt aanmaken, 
hoe je een kruistabel opzet en hoe je rapporteert over de resultaten.
Het volgende, derde, hoofdstuk begint opnieuw met herhalingsoefeningen. 
Daarna maak je kennis met twee andere manieren om variabelen aan te 
maken, leer je hoe je tabellen kunt produceren van vragen waarop meer 
antwoorden mogelijk zijn en hoe je dergelijke tabellen moet lezen. Tot slot 
volgt een korte uitleg over meetniveaus.
Na de gebruikelijke herhaling komt in hoofdstuk  een nieuw type afbeel-
ding aan de orde, de boxplot. Ook leer je informatie uit open vragen verwer-
ken en ga je een zogenoemd stapeldiagram maken. Dit laatste doe je in Ex-
cel. Tot slot bespreken we een variant van een methode om nieuwe 
variabelen te maken die je kunt gebruiken om correcties aan te brengen in 
je bestand.

http://www.spssvoormarktonderzoek.noordhoff.nl
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DEEL 1

SPSS 22  
Beschrijvende techniek

Les 1 11
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. Algemene inleiding in SPSS
. Opmaken van het bestand via Variable View
. Invoeren van gegevens
. Commando Data File Information
. Maken van frequentietabellen
. Opmaken van het bestand via Define Variable Properties
. Omgaan met ontbrekende scores (missing values)
. Interpreteren van frequentietabellen

De eerste kennismaking met SPSS (Statistical Package for the Social Scien-
ces) bestaat uit een korte uitleg over het pakket (in paragraaf .), over wat 
wordt verstaan onder het ‘opmaken’ van een bestand en hoe je dat kunt 
doen (paragraaf .). In paragraaf . bouw je een bestand op aan de hand 
van enkele ingevulde vragenlijsten. Je leert hoe je kunt vaststellen hoe een 
bestand is opgemaakt via Data File Information (in paragraaf .). Daarna 
draai je de eerste tabellen uit (paragraaf .). In paragraaf . leer je een be-
stand opmaken via Define Variable Properties. Deze weg is vooral van be-
lang als je foute of ontbrekende invoer wilt opsporen, de zogenoemde mis-
sing values. Hoe je met missing values moet omgaan, komt in paragraaf . 
aan de orde. Ter afsluiting volgt in paragraaf . een uitleg over het interpre-
teren van frequentietabellen.

Hoofdstuk  begint met een herhaling van alles wat in hoofdstuk  aan de 
orde kwam. Nog meer oefenen kan via de website 
spssvoormarktonderzoek.noordhoff.nl waar je ook alle in deze en volgende 
lessen benodige bestanden kunt vinden.

1 
Les 1

http://www.spssvoormarktonderzoek.noordhoff.nl
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§ 1.1 Algemene inleiding in SPSS

Wanneer je SPSS opstart, zul je zien dat het beeldscherm veel gelijkenis ver-
toont met andere Windows-programma’s, zoals het spreadsheetprogramma 
Excel. Zie figuur .. Vóór het eigenlijke openingsscherm is een menu ge-
schoven dat handig is als je verder wilt werken met eerdere bestanden, 
maar dit is voor ons niet van toepassing. Sluit dit scherm.

FIGUUR 1.1 Openingsscherm (1)

Sluit

Nu het menu verdwenen is, verschijnt figuur .. (Mocht je een ander 
scherm zien, klik dan linksonder op de tab Data View.)

Het binnenhalen en bewaren van bestanden verloopt zoals bij elk ander 
Windows-bestand. Gebruik de knoppen Open en Save as onder File in de 
taakbalk linksbovenaan het scherm.

SPSS-bestanden zijn te herkennen aan de extensie ‘.sav’. Tabellen en grafie-
ken worden door SPSS weggeschreven in output-bestanden die eindigen op 
‘.spv’. Bij oudere versies eindigen output-bestanden op ‘.spo’.

Het lege rasterscherm dat je voor je ziet, bestaat uit rijen (regels) en kolom-
men. De rijen zijn de horizontaal aaneengesloten cellen, de kolommen be-
staan uit de verticaal aaneengesloten cellen. Wat je straks gaat invoeren in 
het bestand, zijn de antwoorden van de respondenten op vragen uit een 
vragenlijst in de vorm van cijfers.

Voor het invoeren reserveer je voor elke respondent één rij. Dus op de eerste 
regel komt alle informatie van respondent , op de tweede regel alles van 

Extensie

Rijen

Kolommen
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respondent  enzovoort. Een rij is eindeloos lang, je kunt er veel informatie 
in kwijt, ook tekst van antwoorden op open vragen.

FIGUUR 1.2 Openingscherm (2)

Rijen

Moet op
Data View staan

Kolommen

Het valt aan te raden, voordat je met de data-invoer begint, de vragenformu-
lieren te nummeren en dit nummer op te nemen in het computerbestand. 
Het zal je maar gebeuren dat je halverwege niet meer weet of je met de lin-
ker- of met de rechterstapel was begonnen. Bovendien kun je niet meer te-
rug naar de originele formulieren als je een fout in het bestand tegenkomt.

Het respondentnummer voer je als eerste in, in de eerste kolom.

 Rijen liggen horizontaal; kolommen staan verticaal.
 Elke respondent krijgt een eigen rij (regel).
 Het eerste gegeven in elke rij is bij voorkeur het respondentnummer.

§ 1.2 Opmaken van het bestand via Variable View

In figuur . zie je een vragenformulier dat is gebruikt bij een marktonder-
zoek. Je gaat het computerbestand opmaken voor dit vragenformulier.

Respondent-
nummer
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FIGUUR 1.3 Voorbeeld van een vragenformulier

1 Bent u met de auto of op een andere manier gekomen?
 1 �Met de auto
 2 �Anders

2 Beschouwt u zichzelf als een tevreden of als een ontevreden klant van 
deze winkel? U kunt kiezen uit de antwoorden…

 (OPTIES VOORLEZEN)
 1 �Zeer tevreden
 2 �Tevreden
 3 �Ontevreden
 4 �Zeer ontevreden

3 Mag ik het bedrag noteren dat u zojuist heeft afgerekend?
 €………

4 Graag heb ik een indicatie van uw leeftijd. Wilt u aangeven in  
welke klasse u thuishoort? Bent u … (OPLEZEN WAT HET MEEST IN 
 AANMERKING KOMT)

 1 �Jonger dan 30 jaar
 2 �30 t/m 49 jaar
 3 �50 jaar of ouder

 Ik dank u vriendelijk voor uw medewerking

…………………………………………………………………………………

 (NIET VRAGEN)
5 Geslacht 1 �Man 

2 �Vrouw

6 Vestiging 1 �Utrecht
  2 �Houten

Je ziet op het vragenformulier in figuur . vóór elke antwoordmogelijkheid 
een cijfer staan. Als een antwoord is aangekruist, voer je het betreffende cij-
fer in het bestand in.

Voor je begint met het invoeren, is het gebruikelijk een zogenoemd code-
boek te maken. Het codeboek dat hoort bij de vragenlijst uit figuur . is in 
figuur . afgedrukt.

→ Vergelijk de vragenlijst met het codeboek.
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FIGUUR 1.4 Codeboek behorend bij de vragenlijst uit figuur 1.3

Respnr Respondentnummer

vraag1 Met de auto of anders gekomen
  1 = Met de auto gekomen
  2 = Anders gekomen

vraag2 Tevredenheid
  1 = Zeer tevreden
  2 = Tevreden
  3 = Ontevreden
  4 = Zeer ontevreden

vraag3 Bestede bedrag

vraag4 Leeftijd in drie klassen
  1 = Jonger dan 30 jaar
  2 = 30 t/m 49 jaar
  3 = 50 jaar of ouder

vraag5 Geslacht
  1 = Man
  2 = Vrouw

vraag6 Vestiging
  1 = Utrecht
  2 = Houten

Voordat je de cijfers in het bestand opneemt, voer je de informatie uit het 
codeboek in de computer in. Dit heet het ‘opmaken’ van het bestand. De 
computer moet weten dat bijvoorbeeld het cijfer  bij ‘vraag’ betekent ‘Met 
de auto gekomen’ en dat de  bij ‘vraag’ staat voor ‘Ontevreden’.

Om te kunnen opmaken, klik je links onder op de tab Variable View. Zo kom 
je in het opmaakscherm.
→ Probeer dit.

→  Je gaat nu het bestand opmaken dat hoort bij de vragenlijst uit figuur .. 
Om dat te kunnen doen, moet je scherm in de goede uitgangspositie 
staan. Om zeker te zijn dat dit het geval is, klik je linksonderaan op het 
scherm op het tabblad Variable View, zoals te zien in figuur ..

Codeboek

Variable View

Opmaakscherm
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FIGUUR 1.5 Tabblad Variable View

Moet op
Variable View staan

Onder Name in de eerste kolom van het opmaakscherm komt een aandui-
ding van elke variabele. De naam (name) mag geen leestekens of spaties be-
vatten. In de eerste kolom van het bestand komt volgens het codeboek (in 
figuur .) het respondentnummer. ‘Respnr’ is een geldige naam. In de regel 
eronder komt de naam die je aan vraag  geeft: ‘vraag’ (zonder spatie).

‘Vraag ’, met een spatie, zou SPSS niet accepteren. Probeer het maar eens. 
Variable name contains an Illegal character is de reactie.
De namen in de zes cellen onder ‘vraag’ verwijzen naar de vraagnummers 
uit het codeboek. Zie figuur ..

Het gaat om een interne naam. Deze naam is niet zichtbaar in de tabellen 
en grafieken die je gaat maken. Het maakt dus weinig uit wat je ervan 
maakt. Met een zekere logica doe je jezelf wel een plezier.
Elke naam mag maar één keer voorkomen.

FIGUUR 1.6 Het geven van een interne naam aan de variabelen

Een naam geven

Name
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Boven de volgende kolom zie je Type staan, met daaronder alle variabelen 
op de standaardstand: Numeric (numeriek). Dit betekent dat SPSS verwacht 
dat je hier cijfers gaat invoeren. Omdat de variabelen in de vragenlijst waar 
je nu mee werkt allemaal numeriek van aard zijn (dus geen tekst bevatten), 
hoef je niets te veranderen.

→  Klik op de numeriekaanduiding van een van de variabelen. Je zult dan 
een menu (zoals in figuur .) zien verschijnen. Mocht je bijvoorbeeld 
antwoorden op een open vraag willen invoeren, dan kun je hier String 
aanvinken, wat ‘tekstveld’ betekent.

FIGUUR 1.7 Het omzetten van een numerieke variabele naar een ander format

Klik

→  Zet in het menu vervolgens alle decimalen op . Decimalen zijn alleen 
van toepassing als je bijvoorbeeld een geldbedrag tot op de cent nauw-
keurig zou willen invoeren (bijvoorbeeld: , euro). In onze vragenlijst 
komt dat niet voor. (Weliswaar is er een vraag naar het bestede bedrag, 
maar daar gaat het om hele euro’s.) Klik op OK om te sluiten.

Boven de volgende kolom staat Width (breedte). Dit kun je meestal nege-
ren. Alleen als je meer ruimte nodig hebt om iets in te typen, zoals een 
tekstregel, kun je door het verhogen van het cijfer een bredere kolom gene-
reren.

Type

Numeric

String

Decimalen

Width
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Bij de volgende kolom kun je het aantal decimalen (Decimals) aangeven. 
Die had je onder Type al op nul gezet, maar het had dus ook hier gekund 
(zie figuur .).

FIGUUR 1.8 Veranderen decimalen en toekennen Labels

→  Voeg nu onder Label (etiket) per vraag de tekst toe, waarvan je wenst dat 
deze straks boven de tabellen verschijnt. ‘vraag’ krijgt als Label ‘Met de 
auto of anders gekomen?’, vraag: ‘Tevreden of ontevreden klant?’ enzo-
voort.

Het label mag veel langer zijn dan de name, bijvoorbeeld een hele zin. Ook 
het gebruik van leestekens is geen probleem. Vaak wordt de hele vragenlijst-
vraag opgenomen.
Mocht je het plezierig vinden de hele tekst te kunnen lezen op het scherm, 
dan kun je de kolom met de muis verbreden. Voor het bestand heeft dat 
geen gevolg.

Als volgende ga je de betekenis van de waarden vastleggen. De computer 
moet weten wat straks de eentjes en tweetjes in het bestand betekenen.

→  Klik achter ‘vraag’ onder Values op het grijze blokje. Er verschijnt een in-
voermenu. Wat je hier moet invullen, kun je terugvinden in het codeboek 
(figuur .). ‘’ staat voor ‘Met de auto gekomen’, ‘’ voor ‘Anders gekomen’.

Voor het respondentnummer en het bestede bedrag (‘vraag’) hoef je onder 
Values niets in te vullen. Deze variabelen bestaat uit een lange lijst met cij-
fers. Wanneer iemand tien euro heeft gespendeerd, is achter Labels aange-
ven dat de respondent tien euro uitgaf onzin; value labels zijn daarom niet 
van toepassing.

→  Klik op Add en voeg de tweede waarde toe. Het eindresultaat moet eruit 
zien als in figuur ..

 Decimals

Label

Values

Value labels



© Noordhoff Uitgevers bv  LES 1 19

1

FIGUUR 1.9 Het toekennen van Value Labels

1

4

2

3

5

Als je alle value labels hebt toegevoegd, klik je op OK. Vervolg de procedure 
voor de overige vragen.
In figuur . zie je wat je scherm moet tonen als je klaar bent.

FIGUUR 1.10 Het bestand opgemaakt volgens het codeboek in figuur 1.4

Je ziet dat er nog meer ingevoerd kan worden. Op Missing komen we terug 
in paragraaf . en Measurement Level komt in paragraaf . aan de orde.
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 Een bestand kun je opmaken in het tabblad Variable View.
 Name is de interne benaming van een variable. Geen leestekens; geen 

dubbele namen.
 Achter Label vul je desgewenst een hele vraag in. Dit komt boven de ta-

bellen en grafieken te staan.
 Via Values geeft je de betekenis van de cijfers in het bestand aan.

§ 1.3 Invoeren van gegevens

Nu ga je de onderzoeksgegevens invoeren, de data-entryfase.
→ Klik links onderaan op de tab Data View om in het invoerscherm te komen.

FIGUUR 1.11 Naar het tabblad met de gegevens, via Data View

Moet op
Data View staan

In figuur . tref je acht ingevulde vragenformulieren aan.

Kijk naar de acht vragenlijsten in figuur .. Het is de bedoeling is dat je de 
cijfers bij de aangekruiste antwoorden overneemt in het bestand. Ga daarbij 
als volgt te werk:
 Neem voor elk vragenformulier één regel.
 In de eerste cel van elke regel zet je het nummer van het vragenformulier 

(= respondentnummer).
 In de volgende cellen voer je per regel de cijfers in die achter elk aange-

kruist hokje staan.
 De bedragen, bij de vraag naar het afgerekend bedrag (‘vraag’), neem je 

letterlijk over, zonder het euroteken.

Data View
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FIGUUR 1.12 In te voeren vragenlijsten
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FIGUUR 1.12 In te voeren vragenlijsten (vervolg)

Bij het invoeren worden wel eens fouten gemaakt. Als je onmogelijke scores 
in tabellen vindt, kom je hier snel achter. Wie ze aantreft en graag degelijk 
werk levert, gaat terug naar de originele formulieren om het te herstellen. 
Dat kan alleen als je een nummer van elk formulier in het bestand hebt op-
genomen (het respondentnummer).

Op het scherm zie je dat SPSS de rijen ook genummerd heeft, met cijfers die 
zo op het oog overeenstemmen met het respondentnummer. Misschien 

Respondent-
nummer
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denk je daarom het respondentnummer niet nodig te hebben. De praktijk 
leert echter dat het vaak voorkomt dat je je bestand anders wilt ordenen (via 
Data → Sort Cases). In het voorbeeldbestand kun je je voorstellen dat je 
eerst de gegevens van alle respondenten uit Utrecht, dan die uit Houten, of 
eerst die van de mannen en dan die van de vrouwen, wilt zien. Het SPSS-
blok met nummers is een vast blok dat niet meesorteert. Als je eenmaal ge-
sorteert hebt (en vervolgens gesaved) ben je de link met de vragenlijsten de-
finitief kwijt.

Het resultaat van je inspanningen moet eruit zien als afgebeeld in figuur 
.a óf figuur .b. Dat is afhankelijk van de voorinstelling van SPSS op 
jouw computer. Je kunt schwitchen tussen beide schermen door op Value 
Labels onder View te klikken. Zie figuur ..

→  Klik op Value Labels en Values om het effect te zien. Het maakt niets uit 
voor het bestand of de output die je straks gaat produceren.

FIGUUR 1.13a Het bestand met ingevoerde gegevens, de labels in beeld (Values)

FIGUUR 1.13b Het bestand met ingevoerde gegevens, de labels in beeld  
(Value Labels)

Sort Cases

Value Labels
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Je kunt naar believen op je scherm wisselen tussen de cijfers en de Value 
Labels in je bestand, via Value Labels, onder View.

FIGUUR 1.14 Switchen tussen Value Labels en Values

Klik

§ 1.4 Commando Data File Information

Je hebt nu de opmaak van het bestand af en de gegevens zijn ingevoerd. Het 
bestand is klaar voor analyse.
Voor je administratie laat je SPSS een overzicht produceren van de opmaak 
via Display Data File Information. Zie ook figuur ..

→ Klik op File → Display Data File Information → Working File.

Display Data  
File Information
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FIGUUR 1.15 Het commando Display Data File Information

1

2

In figuur . zie je de output die SPSS oplevert na het commando Display 
Data File Information.
Als je straks werkt met een bestand van een echt onderzoek, dan save je 
deze tabel en bewaar je hem. Vaak zul je de tabel opnemen in een bijlage 
van je rapport, zodat controleerbaar blijft wat je hebt gedaan en er later 
eventueel een andere marktonderzoeker mee aan de slag kan.
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FIGUUR 1.16 Resultaat van Display Data File Information

§ 1.5 Maken van frequentietabellen

Er zijn twee soorten tabellen te onderscheiden, te weten frequentietabellen 
en kruistabellen. In deze les leer je hoe je frequentietabellen, ook wel rechte 
tellingen genoemd, kunt uitdraaien. Kruistabellen volgen in les .
In een frequentietabel kun je zien hoe de waarden van een variabele ver-
deeld zijn.

→  Maak een frequentietabel van de variabele ‘Met de auto of anders 
 gekomen?’
Het werkt als volgt:

 Ga via Analyze en Descriptive Statistics naar Frequencies, zoals in figuur 
. in beeld gebracht.

 Schuif de naam van de variabele, waarvan je de tabel wilt maken, naar 
het rechter witte vlak. Hier ‘Met de auto of anders gekomen?’, klik op OK.

Er schuift een output-scherm voor je datascherm met daarop de tabel die je 
wenste. Je ziet de tabel in figuur ..

Rechte tellingen

Frequentietabel
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FIGUUR 1.17 Frequentietabellen maken

1

2

4

3

FIGUUR 1.18 Frequentietabel van de variabele ‘Met de auto of anders gekomen?’, 
ruwe SPSS-output

→  Open vervolgens een document in Word. Via knippen en plakken kun je de 
SPSS-output in de Word-file plaatsen die je onderzoeksverslag voorstelt.

Opdrachtgevers zijn zéér gevoelig voor de opmaak van tabellen. Output zo-
als in figuur . kun je niet presenteren. Bewerk daarom de tabel tot je on-

Output
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geveer het resultaat van figuur . krijgt. Je haalt kolommen weg die er niet 
toe doen en vervangt de Engelse termen door Nederlandse.
→ Doe dat.
 Het is handig daarvoor eerst duidelijk te hebben hoe de tabel is samenge-

steld. Dat kun je doen door de rasterlijnen zichtbaar te maken.
Selecteer de hele tabel → Start → Rasterlijnen, alle randen. Je kunt nu 
zien hoe de cellen verdeeld zijn over de tabel.
Maak er vervolgens een ‘egale’ tabel van (zonder samengevoegde cellen). 
In dit geval is alleen de cel linksboven afwijkend. Klik op deze cel → Ont-
werpen → tabel tekenen. Verdeel de cel met de ‘pen’ verticaal in tweeën, 
zodanig dat een tabel ontstaat met  ×  cellen.

 Nu kan het echte opmaken beginnen.
Voor het weghalen van kolommen, zoals ‘Cumalitive Percent’, selecteer je 
de kolom → rechtermuisklik → ‘Kolommen verwijderen’. Herhaal dit 
voor de kolommen met Valid en Valid Percent.
Vervang tot slot de Engelse termen door Nederlandse.
Hoe het kan worden, zie je in figuur .. (De aangebrachte lijnen en 
kleuren doen niet ter zake.) Alleen een tabel die ongeveer zo is opge-
maakt, mag je opnemen in een onderzoeksverslag.

FIGUUR 1.19 Word-document met frequentietabel van de variabele ‘Met de auto of 
anders gekomen?’

Aantal Procent

Met de auto gekomen 5   62,5

Anders gekomen 3   37,5

Totaal 8 100,0

→  Maak nu een frequentietabel van de variabele ‘Tevreden of ontevreden’. 
Maak de tabel zodanig op dat hij in een onderzoeksverslag kan worden 
opgenomen. Hoe het kan worden, zie je in figuur ..

FIGUUR 1.20 Word-document met frequentietabel van de variabele ‘Tevreden of 
ontevreden’

Tevredenheid

Aantal Procent

Zeer tevreden 2   25,0

Tevreden 4   50,0

Ontevreden 2   25,0

Totaal 8 100,0

→  Het bestand waarmee je tot dusverre hebt gewerkt, kun je sluiten. Op-
slaan mag, maar we komen er in dit boek niet op terug. Je kunt het ook 
op de website terugvinden als: ‘Bestand vragenlijst les .sav’.
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 Een frequentietabel maak je via Analyze → Descriptive Statistics → 
 Frequencies.

 Een door SPSS geproduceerde frequentietabel moet je altijd opmaken 
voordat je hem in een rapport opneemt.

§ 1.6 Opmaken van het bestand via Define Variable 

Properties

→  Kopieer van de website www.spssvoormarktonderzoek.noordhoff.nl het 
bestand: ‘Les +. Amusementsmonitor.sav’ naar een eigen harde schijf. 
open daarna het bestand vanuit SPSS.

Het bestand hoort bij een (fictief ) grootschalig onderzoek waarin wordt ge-
zocht naar factoren die samenhangen met iemands geluksgevoel. Het on-
derzoek is genaamd Amusementsmonitor.

→  Het is je opdracht om het SPSS-bestand op te maken, dus Labels en Value 
Labels toe te kennen. Je leert daarvoor echter een andere weg bewande-
len dan hiervoor uitgelegd is.

 Het opmaken gebeurt aan de hand van het codeboek in figuur ..

FIGUUR 1.21 Codeboek ‘Les 1+2. Amusementsmonitor.sav’

vraag1 Geslacht

1 Man

2 Vrouw

vraag2 Woonregio

1 Ten noorden van de Waal

2 Ten zuiden van de Waal

vraag3 Ervaren geluksgevoel

1 Gelukkig

2 Niet (zo) gelukkig

vraag4 Dagelijks werk

1 Student

2 In loondienst

vraag5 Aantal kinderen

vraag6 Leeftijd

vraag7 Aantal belminuten, in 3 klassen

http://www.spssvoormarktonderzoek.noordhoff.nl
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→  Klik om in het opmaakscherm te komen onder Data in de bovenste taak-
balk op Define Variable Properties. De variabelen die je wilt opmaken, 
schuif je naar rechts.
Onderaan zie je staan: Limit number of values displayed to:  (zie fi-
guur .a).

TIP

Leer jezelf aan om consequent de vink die ervoor staat, weg te halen. Het 
programma kijkt anders niet verder dan 200 regels. Het bestand waarmee 
je nu werkt, heeft er 1.386.

→  Klik op Continue. In het menu dat op het scherm verschijnt (figuur .b) 
kun je starten met het opmaken van de variabele die bovenaan de lijst in 
het menu staat. Hier is dat ‘vraag’. Volgens het codeboek hoort bij deze 
variabele het label ‘Geslacht’ en zijn  en  de waarden, wat respectieve-
lijk voor ‘Man’ en ‘Vrouw’ staat. SPSS telt  mannen en  vrouwen. 
Decimalen zijn niet van toepassing, die zet je op .

Je ziet dat SPSS behalve de waarden  en  nog een  en een  vermeldt. De 
bedoeling is dat je deze wegklikt als Missing. In paragraaf . komen we 
hierop terug. Eventueel kenmerk je deze scores met het label ‘Onbekend’ of 
‘Geen antwoord’.

→  Herhaal de procedure voor de andere variabelen. Je gaat naar de volgen-
de variabele door de naam ervan in het linkervak van het menu aan te 
klikken.

Bij ‘vraag’ en ‘vraag’ (‘Aantal kinderen’ en ‘Leeftijd’) bestaan de gegevens 
uit cijfers; dat zijn zogenoemde metrische variabelen (Scale). Je hoeft alleen 
het Label rechtsboven en de decimalen aan te geven. Wel moet je goed con-
troleren op onmogelijke scores (bijvoorbeeld een negatief cijfer of een leef-
tijd boven de honderd). Als je ze aantreft, behoor je het vakje Missing aan te 
kruisen. Over missing values volgt nu een korte uitleg.

Define Variable 
Properties

Scale
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FIGUUR 1.22a Het opmaken van het bestand via Define Variable Properties (1)

1

2

3

4

5

FIGUUR 1.22b Het opmaken van het bestand via Define Variable Properties (2)

Klik

1

2

4
3

5
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§ 1.7 Omgaan met ontbrekende scores (missing 

values)

Je kunt je voorstellen dat bij de invoer van gegevens in de computer, de 
 data-entry fase, wel eens iets misgaat. Wanneer scores worden verwisseld 
(‘man’ in plaats van ‘vrouw’, of ‘ja’ in plaats van ‘nee’), valt dit niet op. Maar 
je kunt ook onmogelijke of ontbrekende scores tegenkomen, zoals de waar-
den  en , terwijl alleen  en  betekenis hebben. Dergelijke fout ingevoer-
de, of missende, scores moeten buiten beschouwing blijven bij berekenin-
gen en in tabellen. Je geeft dit te kennen door een vink te plaatsen bij 
Missing.

Er zijn drie typen missing values:
 Ontbrekende scores. SPSS heeft geconstateerd dat ergens niets is ingevuld. 

Het programma zet dit intern automatisch om in een nul. Hoewel het 
programma deze  onderscheidt van een ingevoerde waarde , is het niet 
handig in je codeboek deze waarde op te nemen als geldige invoer (bij-
voorbeeld: man = , vrouw = ).
Als je een nul tegenkomt in je bestand, ga je in de praktijk via het respon-
dentnummer op zoek naar de bijbehorende vragenlijst om de geldige in-
formatie alsnog te achterhalen. Als je de nul laat staan, moet je onder 
Data → Define Variable Properties dit cijfer aanvinken als Missing.

 Foute scores. Soms is duidelijk sprake van een vergissing. Volgens het co-
deboek komen bijvoorbeeld alleen de waarden  en  voor, maar er staat 
ook een ander cijfer tussen, denk aan een  of een . Ook dan is het de be-
doeling dat je probeert de fout te herstellen, maar als dat niet kan, vink je 
Missing aan in het opmaakmenu.

 Afgesproken codes. Een bijzonder geval zijn missing values in de vorm van 
een code. Soms geeft men op de data-entry-afdeling via een afgesproken 
waarde te kennen dat een gegeven niet beschikbaar is. Je hoeft dan niet 
terug naar het originele vragenformulier voor herstel. Voorbeelden zijn 
– in een rijtje met leeftijden, of  als alleen  en  geldige scores zijn. 
Welke waarden wat betekenen, is een kwestie van afspraak.
Ook van zo’n gegeven moet je uiteraard aanvinken dat het om een mis-
sing value gaat.

  Wanneer  een geldig antwoord is (zoals bij ‘vraag’: ‘Hoeveel kinderen 
heeft u?’), kun je niet hebben dat er ontbrekende scores zijn, omdat SPSS 
deze intern omzet naar . De data-entry-afdeling zal in zo’n geval – inty-
pen. Niet , want iemand kan negen kinderen hebben.

Waar het om gaat, is dat onbrekende of foutieve scores de uitkomsten van be-
rekeningen niet mogen vertekenen. Als je ze hebt aangevinkt als Missing, zet 
SPSS ze als het ware apart en houdt ze buiten beschouwing bij berekeningen.

Voor alle drie de varianten kun je eventueel iets als ‘Onbekend’ of ‘Geen 
antwoord’ toevoegen als Value Label.

Je hebt nu geleerd een bestand op twee manieren op te maken: via het tab-
blad Variable View en via Define Variable Properties.
Werk je via Variable View, dan schiet dat sneller op. Je kunt vlotter doorty-
pen; heb je vragen met steeds dezelfde antwoordblokken (‘zeer mee eens’, 

Data-entry fase

Missing values

Ontbrekende 
scores

Foute scores

Afgesproken 
 codes
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‘mee eens’ enzovoort), dan kun je die blokken via kopiëren en plakken ra-
zendsnel plaatsen.
Variable View geeft echter geen zicht op missing values. Daarvoor heb je 
 Define Variable Properties nodig.

TIP

Kies je voor opmaken via Define Variable Properties, dan kun je twee waar-
den als missing value aanvinken. Werk je via Variable View, dan kun je er 
drie kwijt.

 Het is belangrijk altijd te controleren op missing values.
 Missing values spoor je op en vink je aan via Define Variable Properties.
 In je codeboek is nul bij gegevens in klassen geen geldige waarde.

§ 1.8 Interpreteren van frequentietabellen

Wanneer je alle Labels en Value Labels hebt toegevoegd en de Missing 
 Values zijn aangevinkt, klik dan op het tabblad Variable View. Je behoort 
dan het scherm, zoals afgebeeld in figuur . voor je te hebben.

FIGUUR 1.23 Het opgemaakte bestand Amusementsmonitor.sav

→ Draai, om te beginnen, een frequentietabel uit van variabele ‘vraag’, 
over het ervaren geluksgevoel.
 Analyse → Descriptive Statistics → Frequencies.

De ruwe output die verschijnt, nadat je op OK hebt geklikt, zie je in figuur 
. staan. Deze tabel bevat veel informatie. Wat moet je daaruit rapporte-
ren in je onderzoeksverslag? In de tabel zie je een kolom met absolute aan-
tallen en drie met percentages. Waar moet je kijken?
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FIGUUR 1.24 Frequentietabel van het ervaren geluksgevoel, ruwe SPSS-output

Hier moet 
je kijken

De bedoeling is dat je in je verslag vooral rapporteert over de procentuele 
verdeling van de scores. De absolute aantallen (onder Frequency) doen er 
niet veel toe. (Ervan uitgaande dat je een steekproef hebt van minstens vijf-
tig respondenten. Als er minder zijn, rapporteer je juist alleen de absolute 
aantallen.)

De meest rechtse kolom, met cumulatieve percentages, heeft alleen een 
functie bij metrische gegevens (Scale) ofwel cijfers, zoals leeftijden, lengtes 
of inkomens. Als je werkt met klassen, zoals bij geluksgevoel, is deze kolom 
zonder belang.

Resteren nog twee kolommen. In de linkerkolom, onder ‘Percent’, zijn de 
missing values meegeteld bij het berekenen van de percentages, terwijl ze in 
de kolom er rechts van, onder Valid Percent, buiten beschouwing zijn gela-
ten. Het is deze laatste kolom waarin je moet kijken. Valid Percent kun je 
vertalen met geldige percentages.
De juiste interpretatie van de tabel luidt:

Voor het onderzoek zijn . personen geënquêteerd.
Van hen omschrijft % zichzelf als ‘gelukkig’ en % als  
‘niet (zo)  gelukkig’.

Alleen als het aandeel missing values groot is, grofweg meer dan %, maak 
je er melding van, want dan zijn het geen fouten, maar is er een structurele 
oorzaak. Het kan bijvoorbeeld zijn dat de respondenten de vraag overslaan, 
omdat ze geen belang hechten aan een onderwerp of omdat ze er geen er-
varing mee hebben. Dat kan interessant zijn voor de opdrachtgever.

Cumulatieve 
 percentages

Percent

Valid Percent

Missing values
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Verder valt je misschien op dat bij de interpretatie van de tabel de decima-
len achterwege zijn gelaten. Als in de tabel staat ,%, zetten we in de be-
schrijving %. Dat is met opzet gedaan. Het zeer grote aantal potentiële 
foutenbronnen dat steekproefonderzoek kenmerkt, verhoudt zich slecht tot 
het gebruik van cijfers achter de komma. De decimalen suggereren een gro-
tere mate van precisie dan je kunt waarmaken.

Ruwe SPSS-output, zoals te zien in figuur ., mag je nooit onopgemaakt in 
een onderzoeksverslag opnemen. Het moet mooier en duidelijker. In figuur 
. staat dezelfde tabel, maar nu opgemaakt.

→  Kopieer de SPSS-tabel naar een Word-document dat je onderzoeksver-
slag voorstelt.

 Selecteer de hele tabel → maak de hulplijnen zichtbaar: Start → Rasterlij-
nen, alle randen. Je kunt nu zien hoe de cellen verdeeld zijn over de tabel.
Maak er vervolgens een tabel van met  ×  cellen, zonder samengevoeg-
de cellen. Zet daartoe de cursor ergens in de cel met Valid. → Indeling → 
‘Cellen splitsen’ → Aantal kolommen , Aantal rijen . Herhaal dit voor 
de cel met Missing. De lege cel linksboven en de cel met Total linksonder, 
splits je vervolgens in  kolommen en  rij. Trek met de muis alle cellen 
van de eerste kolom tot dezelfde breedte.

 Nu kun je pas met opmaken beginnen.
Zet de cursor in Cumulative Percent, want die kolom moet weg. Rechter-
muisklik → ‘Cellen verwijderen’ → ‘Hele kolom verwijderen.’
Hetzelfde doe je met de eerste kolom.
Zie figuur . voor het resultaat zoals het ongeveer kan worden, extra 
kleuren en toegevoegde lijntjes daargelaten.

 In de tabel staan twee regels met missing values en nog een voor het to-
tale aantal. Die kunnen net zo goed samengevoegd worden tot één regel. 
Doe dat, maar let er wel op dat je twee missing values overhoudt.

 Het woord Valid in de cel linksboven halen we ook weg en we vertalen 
alle Engelse termen door Nederlandse.

 Nu is zichtbaar dat de uitlijning niet mooi is. De dunne grijsblauwe lijn-
tjes die je op je scherm ziet zijn gedachtestrepen. Als je het document 
print, worden ze niet afgedrukt. Het ‘Gelukkig’ en ‘Niet (zo) gelukkig’ 
moeten verder naar links. Daartoe voegen we de cellen samen. Selecteer 
met je muis de cel met ‘Gelukkig’ en de lege cel er links van. Ga naar 
 Table en klik op Merge Cells. Doe hetzelfde voor ‘Niet (zo) gelukkig’ en 
‘Totaal’.

FIGUUR 1.25 Frequentietabel van het ervaren geluksgevoel, klaar voor het 
onderzoeksverslag

Aantal Percentage

Gelukkig 1.170   84,5

Niet (zo) gelukkig    214   15,5

Subtotaal 1.384 100,0

Onbekend        2

Totaal 1.386
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 Als je een tabel interpreteert, kijk je uitsluitend naar percentages (tenzij 
n < 50, dan rapporteer je op basis van absolute aantallen).

 Je rapporteert alleen uit de kolom Valid Percent, die missing values bui-
ten beschouwing laat.

 In je tekstverslag rond je percentages af op hele getallen.
 Het is belangrijk aan de opmaak van tabellen veel aandacht te beste-

den.

Extra oefenen van de in deze les behandelde stof?
Ga naar www.spssvoormarktonderzoek.noordhoff.nl

http://www.spssvoormarktonderzoek.noordhoff.nl

	Front Cover
	Woord vooraf bij de derde druk
	Inhoud
	Studiewijzer
	DEEL 1SPSS 22 Beschrijvende techniek
	1Les 1
	1.1Algemene inleiding in SPSS
	1.2Opmaken van het bestand via Variable View
	1.3Invoeren van gegevens
	1.4Commando Data File Information
	1.5Maken van frequentietabellen
	1.6Opmaken van het bestand via Define Variable Properties
	1.7Omgaan met ontbrekende scores (missing values)
	1.8Interpreteren van frequentietabellen





